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 Overview
This chapter introduces SnagIt/32, outlines its system requirements and describes its on-line 
documentation and Help facility. It also provides you with information on how to contact us with your 
comments and questions.
What Does Snagit/32 Do?    
Snagit/32 System Requirements    
Using On-Line Documentation    
README.TXT    
Snagit/32 Support    



What Does Snagit/32 Do?
SnagIt/32 provides Microsoft Windows 95 and Windows NT 3.51 (or higher) users with an easy way to 
capture, print, file or mail Windows screen images.
With SnagIt/32, you can capture an entire screen, a portion of the screen, a specific window or the 
contents of a scrollable window. SnagIt/32 also accepts input from the Windows clipboard, or a Windows 
bitmap (BMP) file.
You can send the captured image to a printer, a graphics file, an electronic mailnote or the Windows 
Clipboard.
· Sending the image to the printer allows you to make immediate use of the hardcopy output. 
· Placing the image in a saved graphics file allows you to later import it into your applications. 
· Having the image immediately attached to a mailnote enables the timely and accurate sharing of your

current screen information with others using network mail. 
· Sending the image to the Clipboard allows you to immediately paste the image into other Windows 

applications, such as word processors and desktop publishing programs.



Snagit/32 System Requirements
SnagIt/32 requires the following:

· An IBM PC or compatible that meets Microsoft Windows 95 or Windows NT 3.51 minimum 
hardware requirements.

· Microsoft Windows 95 or Windows NT version 3.51 or later.
· A mouse or other pointing device.
· For mail output, a 32-bit MAPI mail client (e.g., Microsoft Exchange) must be configured.
· For printed output, a Windows-supported printer capable of printing bitmaps.

(This includes most laser, dot matrix and ink jet printers. Note that many plotters cannot print 
bitmaps, and consequently, may not be able to print images captured with SnagIt/32.)



Using On-Line Documentation
SnagIt/32 has a Help system that gives you on-line access to the manual.
Selecting Quick Help from the Help menu provides an instant overview of SnagIt/32 essentials.
For information about how to use on-line Help, choose How to Use Help from the Help menu.
Selecting System Info from the Help menu displays a dialog box that contains information about your 
screen mode and printer type.
Selecting About from the Help menu displays a dialog box listing the version number for this copy of 
SnagIt/32.



README.TXT
Refer to the README.TXT file on the SnagIt/32 diskette for recent information not included in this online 
manual.



Snagit/32 Support
TechSmith is committed to providing a reliable, high-quality product that is easy to use. If you have a 
problem installing or using SnagIt/32, please check our web site, http://www.techsmith.com, for 
Frequently Asked Questions (FAQ) which may be similar to yours. If you still require assistance, please 
contact us in one of the following ways:

E-mail: snagit@techsmith.com
Fax: (517) 333-1888
CompuServe: 75226,3136
Phone: (517) 333-2100
Mail: TechSmith Corporation

Attn.: SnagIt/32 Support
P.O. Box 4758
East Lansing, MI    48826-4758

If you are reporting a problem with SnagIt/32, please provide the following information:
· The product name and version number (SnagIt/32, version 3.1).
· Your name, e-mail address, fax number and phone number.
· Your hardware and software configuration.
· A description of the problem, and what you were trying to do when the problem occurred.



Getting Started
This chapter describes how to install and use SnagIt/32.
Installing SnagIt/32    
Using SnagIt/32    



Installing SnagIt/32
The SnagIt/32 installation program, SETUP.EXE, is a Microsoft Windows application. You must have 
Windows 95 or Windows NT 3.51 (or higher) installed before you can install SnagIt/32.
To install SnagIt/32:

1. Start Windows, if you have not already done so.
2. Insert the SnagIt/32 diskette into a floppy drive.

For Windows 95 users:
3. From the Start menu,    select Run.
4. In the Run dialog box, enter:

a:\setup
(If you are installing SnagIt/32 from a diskette drive other than the a:\ drive, you will need to 
change the drive letter in the command line above.)

For Windows NT users:
3. From the Program Manager menu bar, choose File, and select Run from the drop-down menu.
4. In the File Run dialog box, enter:

a:\setup
(If you are installing SnagIt/32 from a diskette drive other than the a:\ drive, you will need to 
change the drive letter in the command line above.)

For all users:
5. Select the OK button.
6. In the Setup Information box, do the following:

· Enter the name of the directory where you would like SnagIt/32 to be installed, or accept the 
default directory, C:\SNAGIT32.

· Enter the Windows group to which the SnagIt/32 icon should be added, or accept the default 
group, Accessories.

7. In the Startup Options box, do the following:
· If you want SnagIt/32 to load automatically when you start Windows, check the Start 

SnagIt/32 when Windows starts box. This will add SnagIt/32 to the Windows Startup group.
· If you want SnagIt/32 to start as a minimized icon, check the Minimize SnagIt/32 when 

started box.
8. When you have finished entering the setup information, select the Install button to install 

SnagIt/32.



Using Snagit/32
Starting Snagit/32    
Snagit/32 Default Settings    
Invoking Snagit/32 With The Hotkey(s) 
Using The Mouse To Select Images    
Using The SnagIt/32 Toolbar    



Starting SnagIt/32
For Windows 95 users:

· To start SnagIt/32, select the SnagIt/32 icon found in the Start menu, under Programs / 
Accessories. (If you specified a group other than Accessories during SnagIt/32 installation, look in
that group for the SnagIt/32 icon.)

· Selecting the SnagIt/32 icon will execute SnagIt/32 and bring it to the foreground in its maximized
form. When SnagIt/32 is maximized, you can change, or review, any of the setup options (Input, 
Output, Format, etc.) using the SnagIt/32 menus. The Include Cursor, Auto Scroll, Save Setup 
and Help options may also be selected from the Toolbar.

For Windows NT users:
· To start SnagIt/32, select the SnagIt/32 icon in the Accessories group. (If you specified a group 

other than Accessories during SnagIt/32 installation, look in that group for the SnagIt/32 icon.)
· Selecting the SnagIt/32 icon will execute SnagIt/32 and bring it to the foreground in its maximized

form. When SnagIt/32 is maximized, you can change, or review, any of the setup options (Input, 
Output, Format, etc.) using the SnagIt/32 menus. The Include Cursor, Auto Scroll, Save Setup 
and Help options may also be selected from the Toolbar.

If you selected the "Start SnagIt/32 when Windows starts" checkbox during installation, or if you have 
manually placed the SnagIt/32 icon in your Windows Startup group, SnagIt/32 will start automatically each
time you start Windows.



Snagit/32 Default Settings
When you install SnagIt/32, it uses the following default options:

· Input is set to "Screen". SnagIt/32 is configured to capture the entire Windows desktop. The 
Include Cursor option is enabled and the Auto Scroll option is disabled.

· Output is set to "Printer". SnagIt/32 is configured to send the captured image to the Windows 
default printer. The image will be positioned in the upper left corner of the page and scaled to fit 
on a single page.

· Format is set to "Color". SnagIt/32 will capture the image with the screen colors intact. (In most 
cases you can print images captured using this setting, even if your printer is not a color printer.)

· Hotkeys are set to CTRL+SHIFT+P to activate SnagIt/32 and CTRL+SHIFT+X to Hide/Unhide 
the SnagIt/32 icon.

· Scale is set to 1.00. This means that SnagIt/32 will capture the image at its original size when the
Output is File, Clipboard or Mail. Image scaling is ignored when printer scaling options are 
applicable.

A summary of your current settings will always be displayed as a status line in the lower section of the 
SnagIt/32 Control window.



Invoking Snagit/32 With The Hotkey(s)
The default hotkey sequence for invoking SnagIt/32 is CTRL+SHIFT+P. When you press this key 
combination, SnagIt/32 will capture the part of the screen you specified as the input option, and send that 
image to the device you specified as the output option.



Using The Mouse To Select Images
You will need to use a mouse or other pointing device with SnagIt/32. The left and right mouse buttons 
work as follows for right-handed users. Reverse the roles of the buttons if your mouse has been 
configured for left hand use.
Left Button Use the left mouse button to select SnagIt/32 menu options, and to select screen 

regions and windows to capture. The left mouse button is also used to manually 
designate the end of an Auto Scroll capture. 

Right Button Use the right mouse button to cancel a region or window selection. To cancel the 
current selection, press the right mouse button before you release the left mouse 
button. Pressing the right mouse button at any time during an Auto Scroll capture 
terminates the capture without saving it.



Using The SnagIt/32 Toolbar
The SnagIt Toolbar provides convenient access to the following options; Include Cursor, Auto Scroll, 
Save Setup and Help. 

Selecting the Include Cursor button  enables the capturing of your cursor in the selected screen 
image. This option is only available with the Screen and Last Active Window Input options.

Selecting the Auto Scroll button  enables the capture of windows containg a vertical scroll bar. This 
option is only available with the Entire Window, Window Client Area, Last Active Window and Region 
Input options.

Selecting the Save Setup button  saves SnagIt/32's current configuration options as the default for 
future SnagIt/32 sessions.

Selecting the Help button  gives you on-line access to the SnagIt/32 user manual.



SnagIt/32 Configuration Options
This chapter describes how to configure SnagIt/32, including the Input, Output, Format and other Options 
menus, as well as keyboard commands and command-line arguments.
Auto-Load Option    
Keyboard Commands    
Input Options    
Output Options    
Format Options    
Other Options    
Command Line Arguments    



Auto-Load Option
By default, the SnagIt/32 Setup program configures SnagIt/32 to not load automatically whenever you 
start Windows. 
The easiest way to change this configuration after installation is to re-run SnagIt/32 Setup from the 
SnagIt/32 distribution diskette. 

· If you do not have SnagIt/32 configured to load automatically but you want to start loading it 
whenever you start Windows, check the "Start SnagIt/32 when Windows starts" box on the 
SnagIt/32 Setup screen. This will add SnagIt/32 to the Windows Startup group.

· If you have configured SnagIt/32 to auto-load but no longer want it to do this, clear the “Start 
SnagIt/32 when Windows starts” box on the SnagIt/32 Setup screen. This will remove SnagIt/32 
from the Windows Startup group, and SnagIt/32 will no longer load on Windows startup.



Keyboard Commands
Invoking SnagIt/32 From The Keyboard    
Hiding The SnagIt/32 Window    



Invoking Snagit/32 From The Keyboard
The default hotkey sequence for invoking SnagIt/32 is CTRL+SHIFT+P. When you press this key 
combination, SnagIt/32 will capture the part of the screen you specified as the Input option, and send that 
image to the device you specified as the Output option.
Many users prefer to use the Print Screen key as their SnagIt/32 hotkey. To change your hotkey 
sequence to Print Screen, or any other combination, select Options, Change Hotkeys.

Caution: While SnagIt/32 allows users the flexibility to designate their hotkey(s), you should take care 
to use keys and or key combinations that are not used in normal typing or by your other software 
applications.



Hiding The Snagit/32 Window
The default hotkey sequence for displaying or hiding the SnagIt/32 window or icon is CTRL+SHIFT+X. 
When you press this key combination, the SnagIt/32 window or icon will disappear from the Windows 
desktop, leaving SnagIt/32 running. Pressing it again will restore the SnagIt/32 window or icon to the 
Windows desktop.
To change your hotkey sequence, select Options, Change Hotkeys.

Caution: While SnagIt/32 allows users the flexibility to designate their hotkey(s), you should take care 
to use keys and or key combinations that are not used in normal typing or by your other software 
applications.



Input Options
The SnagIt/32 Input options allow you to define the screen area to be captured. Your options include 
Screen, Entire Window, Window Client Area, Last Active Window, Region, BMP File and Clipboard. 
Depending on the area you have chosen, you may also have the additional options of Include Cursor or 
Auto Scroll. Include Cursor incorporates the cursor in the captured screen image. Auto Scroll captures the
extended contents of a scrollable window.
Screen (Input)     
Entire Window (Input)    
Window Client Area (Input)    
Last Active Window (Input)     
Region (Input)     
BMP File (Input)     
Clipboard (Input)     
Include Cursor (Input)     
Auto Scroll (Input)    



Screen (Input) 
Select the Screen option from the SnagIt/32 Input menu to capture the entire Windows desktop 
(everything visible on the screen).
To capture an image of the Windows desktop:

1. Set the input parameter to Screen.
2. To include the cursor in your captured image, select Include Cursor from the Input menu or 

Toolbar.
3. Press your hotkey combination.

Note: Auto Scroll is not available with this option.



Entire Window (Input) 
Select the Entire Window option from the SnagIt/32 Input menu to capture an entire user selected 
window. The captured image will include the border, title bar, menu bar, scroll bars and caption line.
To capture an image of a window:

1. Set the input parameter to Entire Window.
2. To perform a scrolling capture of the contents of a vertically scrollable window, select Auto Scroll 

from the Input menu or Toolbar.
3. Press your hotkey combination.
4. The cursor will change to a finger pointer. Select the desired window by positioning the finger 

pointer inside the window and clicking the left mouse button.

Note: Include Cursor is not available with this option.

WINDOW SELECTION TIP:
To be sure that SnagIt/32 captures the entire window, position the finger pointer in the window's title bar 
before you click the left mouse button to select the window.
Other items within a window, such as the OK and Cancel buttons, are actually small windows. If you 
select one of these items with the finger pointer, you will only capture that item instead of the entire 
window.



Window Client Area (Input) 
Select the Window Client Area option from the SnagIt/32 Input menu to capture the client area of a 
specific window. The client area is the main body of the window inside the window borders. It does not 
include the window borders, title bar, menu bar, scroll bars or caption line.
To capture an image of a window client area:

1. Set the input parameter to Window Client Area.
2. To perform a scrolling capture of the contents of a vertically scrollable window, select Auto Scroll 

from the Input menu or Toolbar.
3. Press your hotkey combination.
4. The cursor will change to a finger pointer. Select the desired window by positioning the finger 

pointer inside the window and clicking the left mouse button.

Note: Include Cursor is not available with this option.



Last Active Window (Input) 
Select the Last Active Window option from the SnagIt/32 Input menu to capture the last active window 
(the window that has the focus on the Windows desktop when SnagIt/32 is invoked).
To capture an image of the last active window:

1. Set the input parameter to Last Active Window.
2. To perform a scrolling capture of the contents of a vertically scrollable window, select Auto Scroll 

from the Input menu or Toolbar.
3. To include the cursor in your captured image, select Include Cursor from the Input menu or 

Toolbar. If you are using Include Cursor in conjunction with Auto Scroll, the cursor can only be 
captured in a scrollable window as part of the initial screen.

4. Press your hotkey combination.



Region (Input) 
Select the Region option from the SnagIt/32 Input menu to capture a user defined rectangular region of 
the screen.
To capture a user defined area as an image:

1. Set the input parameter to Region.
2. To perform a scrolling capture of the contents of a vertically scrollable window, select Auto Scroll 

from the Input menu or Toolbar.
3. Press your hotkey combination.
4. The cursor will change to a hand holding cross hairs. Position the cross hairs in the upper left 

corner of the region you want to capture.
5. If you ARE NOT using Auto Scroll, press and hold the left mouse button. “Drag” the pointer 

diagonally, to the lower right corner of the region. You will see a rectangular outline defining the 
region SnagIt/32 will capture.

6. If you ARE using Auto Scroll, locate the top of the scrollable area of the screen that you wish to 
capture. Press and hold the left mouse button. “Drag” the pointer vertically until you have reached
the bottom of the area to be captured. “Dragging” the pointer beyond the lower limit of the window
will cause the window to scroll automatcally.

7. When you have outlined the region you want to capture, release the mouse button to perform the 
capture.

Note: Include Cursor is not available with this option.



BMP File (Input) 
Select the BMP File option from the SnagIt/32 Input menu to capture an image stored in a Windows 
bitmap file.
To capture an image of a BMP file:

1. Set the input parameter to BMP File.
2. Press your hotkey combination.
3. Enter the name of the file containing the image you want to capture.
4. Select the Open button.



Clipboard (Input) 
Select the Clipboard option from the SnagIt/32 Input menu to capture the contents of the Windows 
clipboard.
To capture an image from the Clipboard:

1. Set the input parameter to Clipboard.
2. Press your hotkey combination.



Include Cursor (Input) 
Select the Include Cursor option from the SnagIt/32 Toolbar, or Input menu, to include your cursor in 
the image that you want to capture. This option    is only available if you have selected the Screen or Last
Active Window options from the SnagIt/32 Input menu.
To include the cursor pointer in your image:

1. Select the Include Cursor button or Input menu option, in combination with either the Screen or 
Last Active Window options.

2. Press your hotkey combination.



Auto Scroll (Input)
Select the Auto Scroll option from the SnagIt/32 Toolbar, or Input menu, to capture the extended 
contents of a window containing a vertical scroll bar. This option is only available with the Entire Window,
Window Client Area, Last Active Window and Region Input options. 

Note: This option is application dependent and may not function with all Windows applications. 
This option may not function correctly with windows that contain moving elements.

To enable the capture of a scrolling window as a single image:
1. Select Auto Scroll button, or Input menu option, in combination with the Entire Window, Window 

Client Area, Last Active Window or Region Input options.
2. Press your hotkey combination.
3. Use your cursor to determine the “scrollable” areas of the screen. 

· Those areas containing a scrolling window that SnagIt/32 can capture as a single image will cause 
the cursor to display a finger pointer, or crosshairs, with a scrolling page attached. The window to 
be captured will also be outlined by thin dashed box. 

Note: Most application windows are actually comprised of many smaller, information and 
control windows, some of which may also be scrollable. Verify that you are selecting the 
correct window by looking for the thin dashed box around the perimeter of the window.

· Those areas SnagIt/32 has determined are not scrollable will cause the cursor to display the normal
finger pointer or crosshairs (These areas can still be captured, but the Auto Scroll option will be 
ignored.)

4. When you have found the desired scrolling region, select it with the left mouse button. If you are 
selecting a Region, you would continue to hold down the left mouse button to define the length of the 
area to be captured. To define an area beyond the displayed area, drag the mouse beyond the 
window’s lower limit and the window will scroll accordingly.

5. Releasing the left mouse button begins the capture process. 
6. The capture process will continue until the lower limit of the designated scrolling window has been 

reached. The left mouse button may be used at any time to prematurely stop and save the capture. 
The right mouse button may also be used to terminate the capture, but the results will not be saved.

Note: Some applications, most notably spreadsheets, have no lower vertical scrolling limit. These 
applications should be captured using the Region Input option or manually terminated to avoid 
potential problems with unusually large file sizes and limited system resources.



Output Options 
The SnagIt/32 Output options allow you designate the destination of the captured image. The captured 
image can be sent to the Printer, the Windows Clipboard, saved to a File or attached to a Mail note.
Printer (Output)     
Clipboard (Output)     
File (Output)    
Send Mail (Output)     



Printer (Output) 
Select the Printer option from the SnagIt/32 Output menu to send the captured image to a printer. 
The Printer Output Setup dialog box allows you to:
1. Select your Default Windows Printer or another Specific Printer of your choice.      
2. Select the page Image Position of your printed output. Your choices are Upper Left, Lower Left, 

Center, Upper Right and Lower Right.    
3. Select the scale Options for the relationship of the image size to the printed page. The options are: 

· Fit Image on a Single Page - The image, regardless of length, will be proportionally scaled to fit on
one page. Example: An Auto Scroll capture, normally 3 pages long, would be scaled equally in 
length and width to print on a single page. The resulting printed image would be 1 page long and 
1/3 of its normal width.

· Proportional - The size relationship between the width of the area being captured and the width of 
the screen will be used to determine the width of the printed image in relationship to the width of the
printed page. Example: An image half the width of your screen will be scaled to print at half the 
width of the printed page.

· Auto Scale - The width of the captured image will be scaled to equal the width of the page. The 
length will be proportionally scaled and may exceed the length of a single page. Example: An image
2 inches wide and 6 inches long will be scaled by an approximate factor of 4 to fit the printed page 
width. The length will also be scaled by the same factor, resulting in a printed image 2 1/2 (24 inch) 
pages in length.

· Manual Scale - The user can apply a scale factor to the image to reduce or increase its size on the 
printed page. The default scale of 1.00 is equal to printed image obtained with the Proportional 
setting. Example: A scaling factor of 2.00 would double the height and width of the printed image.

The default settings for Printer Output Setup are Default Windows Printer, image position is Upper 
Left and image scaling is set to Fit Image on a Single Page. To return the Printer Output Setup settings 
to these values, select the Default button.
When you have finished selecting your Printer Output Setup settings, select OK to begin printing.
While SnagIt/32 is printing, a status box will be displayed. To stop the printing process, select Cancel at 
any time.



Clipboard (Output) 
Select the Clipboard option from the SnagIt/32 Output menu to send the captured image to the Windows
clipboard. Once an image is in the clipboard, you can paste it into another Windows application or save it 
as a clipboard file (.CLP).



File (Output) 
Select the File option from the SnagIt/32 Output menu to save the captured image to a file. With this 
option you can save your files in six graphic file formats. 

· Specify the graphic file format type for your saved image. Select BMP or Compressed BMP for a
Windows Bitmap file, PCX for a PC Paintbrush file, TIF for a Tag Image File, GIF for a or 
Graphics Interchange Format file or JPEG for a JPEG Compressed Graphic file. 
The JPEG option also allows you to select the level of image quality you would like to retain. The 
valid levels are 1% to 99%. Example: A setting of 75 will retain 75% of the original image quality. 

Note: The file format you choose can have a dramatic effect on the saved file size. The 
following are examples of one image (256 colors, 510 pixels by 270 pixels) saved in 
various file formats.

Monochrome Color / Grayscale
BMP 18k 137k
BMP(Compressed) 18k 23k
PCX 5k 21k
TIF 18k 137k
GIF 4k 8k
JPEG - 50% 15k 16k

· If you would like SnagIt/32 to automatically name and sequentially number your saved images, 
select the Automatic File Naming checkbox. In the File Name Prefix dialog box, specify the 
prefix of the named series you would like SnagIt/32 to use when it saves a file automatically (the 
default is SNAG-). As long as this option remains in effect, whenever SnagIt/32 saves a file, it will 
give the file a name composed of the File Name Prefix and a sequential number (i.e., SNAG-1, 
SNAG-2...)

· Specify the Automatic File Naming output drive and directory in the File Output Directory dialog 
box. You have the option of entering the information manually or selecting Browse... to conduct a
drive and directory search.

· Select the OK button when you are finished.

Note: The graphic file format selected will also be used to define the file type used as a mail note 
attachment when the Send Mail Output option is selected.



Send Mail (Output) 
Select the Send Mail option from the SnagIt/32 Output menu to attach the captured image to a mailnote. 
The file type for the attached image is determined by the current File output setting. Once the image is 
attached to the mailnote,    the mailnote will be displayed. You then enter your regular electronic mail 
information and select Send.

Note: The Send Mail output option is only supported if you have a 32-bit MAPI mail client installed
(e.g.,, Microsoft Exchange).



Format Options 
The SnagIt/32 Format options let you choose a color format for the captured image. Your choices are 
Color, Monochrome or Grayscale. You also have the option of Dither Image with Color and Monochrome 
images.
Color    
Monochrome    
Grayscale    
Dither Image    

Note: The file format you choose can have a dramatic effect on the saved file size. The following 
are examples of one image (256 colors, 510 pixels by 270 pixels) saved in various file and color 
formats.

Monochrome Color / Grayscale
BMP 18k 137k
BMP(Compressed) 18k 23k
PCX 5k 21k
TIF 18k 137k
GIF 4k 8k
JPEG - 50% 15k 16k



Color
Select the Color option from the SnagIt/32 Format menu to retain all or part of the screen color 
information with the captured image. The Color option also allows you to specify the number of colors to 
retain with the Color Reduction setting. The number of colors you retain can have a dramatic effect on 
the quality of your output and size of your saved image files. You can select Reduce to 256 Colors, 
Reduce to 16 Colors or None, to retain all the original colors. We recommend using the Format, Dither 
Image option whenever Color Reduction has been selected. We also recommend experimenting with the 
various settings to determine which image quality and file sizes best suit your image requirements.
COLOR FORMAT TIP:
Even if you are using SnagIt/32 to print captured images to a standard, black and white printer, you can 
still leave the format option set to Color. The Windows printer driver for your printer will convert the image 
to grayscale-type output. In fact, most printed images will probably look their best if you set the format 
option to Color.
Unless you have a specific need to capture monochrome or grayscale images, we recommend leaving 
the format option set to Color.



Monochrome
Select the Monochrome option from the SnagIt/32 Format menu to convert the captured image to 
monochrome (black and white). 
With monochrome images, the intensity threshold level determines the amount of black and white that will
appear in the output image. When the captured image consists of predominantly one color, or a small 
number of similar colors, the converted image can end up looking too dark or too light.
When you select Monochrome from the format menu, a dialog box will appear, allowing you to customize
the intensity threshold for a particular image.
In general, you should not need to change the intensity threshold. (Select the OK button to accept the 
default.)
However, if a captured image looks too dark or too light, try adjusting the intensity threshold for the image,
according to the following guidelines:

· If the image is too dark, lower the intensity threshold percentage.
· If the image is too light, raise the intensity threshold percentage.

To revert to the default intensity threshold setting, select the Default button.



Grayscale
Select the Grayscale option from the SnagIt/32 Format menu to convert the captured image to a 
grayscale (black and white patterns that simulate gray).
This option is useful if your printer cannot print color images in black and white. (These printers are 
generally older models, and are relatively rare.) You should note, however, that converting images to 
grayscale is a pixel-by-pixel process, and can be slow.



Dither Image
Select the Dither Image option from the SnagIt/32 Format menu to apply a dithering (color emulation) 
pattern to the captured image. Dithering Image is only available for the Color and Monochrome settings 
(Grayscale inherently applies a dithering pattern to simulate gray from combinations of black and white.) 
This option will only be applied during a color reduction, i.e., color to monochrome or when the Color 
Reduction option is applied, restricting the output to 256 or 16 colors.
This option is most effective on images that contain areas that blend gradually from color to color 
(Photographs, artwork with gradient backgrounds, etc.). It is least effective with areas that contain blocks 
of color (Graphs, screen icons, standard text, etc.).



Other Options
The SnagIt/32 Options menu lists additional SnagIt/32 features and options. These include Alert, 
Clipboard Chain, Color Boost, Change Hotkeys, Scale and Auto Scroll advanced options. You also have 
the option of saving the current SnagIt/32 settings for future sessions by selecting Save Setup.
Alert    
Clipboard Chain    
Color Boost    
Change Hotkeys     
Scale    
Auto Scroll... 
Save Setup    



Alert
Select the Alert option from the SnagIt/32 Options menu to have SnagIt/32 signal you when it has 
finished input or output processing.
When you select the Alert option, a dialog box will be displayed.
In the dialog box:

1. Select Sound Alert when Hotkey is Pressed to indicate that SnagIt/32 should give you an 
audible signal when it begins input processing.

2. Select Sound Alert when Capture is Finished to indicate that SnagIt/32 should give you an 
audible signal when it has completed output processing.

3. Select the OK button, when you are finished selecting your Alert options.



Clipboard Chain
Select the Clipboard Chain option from the SnagIt/32 Options menu to have SnagIt/32 capture the 
contents of the Windows clipboard each time you send something new to the clipboard.
The Clipboard Chain option on the Options menu is a toggle, which is either on or off. To select this 
option:

1. Select the Input option Clipboard,
2. Select any other Output option other than Clipboard, and
3. Select the Clipboard Chain option on the Options menu.

You can use the Clipboard Chain option to capture screens from a full-screen MS-DOS window. When 
you are working in a full-screen MS-DOS session, pressing the Print Screen key* causes Windows to 
copy the screen to the clipboard. If you have selected the Clipboard Chain option, SnagIt/32 
automatically copies the MS-DOS screen image to the specified output device (printer, graphic file or 
mailnote).

*Note - If you will be capturing full screen MS-DOS windows on Windows NT, do not select the 
Print Screen key as the SnagIt/32 activation hotkey. This will interfere with the normal Print 
Screen key function in MS-DOS.



Color Boost
Select the Color Boost option from the SnagIt/32 Options menu to adjust the color palette of a captured 
image. This option gives you custom control of the captured image’s RGB (Red/Green/Blue) values. You 
can use it to:

· Lighten or darken the captured image by altering its color palette;
· Invert the colors of the captured image; or
· Separate an image into its RGB components.

You can use Color Boost to adjust the color intensities for the red, green and blue portions of each pixel. 
On the Color Boost dialog box, you can control the pixel color intensity in two ways:

· Control color saturation by increasing or decreasing the intensity level of individual colors by a 
percentage of the original value. You do this by adjusting the values of the three slider bars. The 
value for each bar (color) ranges from -100% to 1000%. The default value is 100%, which means 
that SnagIt/32 does not change the color value of the original image.

· Control hue by adding or subtracting intensity levels for each color range. You do this by entering 
an offset amount, ranging from -255 to 255, in the Red, Green and Blue Color Enhance boxes. 
The default value is 0, which means that SnagIt/32 does not change the color range of the 
original image.

Once you have modified the RGB values, you must check the Use Color Boost box if you want 
SnagIt/32 to use these values when outputting the captured image.
To restore the default color values, select the Default button.
Selecting the Inverse button will set the RGB slider bar and Color Enhance values to values that invert 
the captured images.
To output inverse images, select the Inverse button. SnagIt/32 will output captured images with inverted 
light and dark values. 

INVERSE IMAGE TIP:
The Inverse option is particularly handy when you are trying to capture full screen MS-DOS windows. 
Often, these screens appear as light or white letters on a dark background. When you select Inverse, 
SnagIt/32 will output the image as dark letters on a light background.

Select the OK button to apply the specified Color Boost values.



Scale
Select the Scale option from the SnagIt/32 Options menu to apply a real scaling factor to a captured 
image before SnagIt/32 outputs the image to a File, the Clipboard or to Mail. This option is ignored if the 
Output selected is Printer.
When you select the Scale option, a dialog box will be displayed. The scale factor you select will reduce 
the size of the image, if it is less than 1.00, or enlarge the image, if it is greater than 1.00.

- A scaling factor of .50 will produce an image 50% smaller in length and width than the original. 
This factor would be appropriate for full screen captures being sent as mailnote attachments. The 
resulting image and file size would be 25% of a similar full scale capture.

- A scaling factor of 1.00 means the output image will be the same size as the captured image. A 
factor of 1.00 will usually be appropriate for captures to the Windows clipboard and to BMP, PCX, 
TIFF or JPEG files.

- A scaling factor of 3.00 means the output image will be three times as large, in length and width, 
as the original captured image. The resulting image and file size would be 900% of a similar full 
scale capture.

SCALE OPTION TIP:
Integer values (whole numbers) scale faster than scale values with non-zero decimal places. Setting the 
scale value to a whole number will give you the best performance.



Auto Scroll...
Select the Auto Scale... option from the SnagIt/32 Options menu to change the Auto Scroll advanced 
configuration settings of Foreground the Scrolling Window and Scroll from Top of Document.

Selecting Foreground the Scrolling Window will cause any scrolling window that is selected for capture 
to be brought to the foreground. This forces the scrolling window to be visible during the scrolling process.
If this option is not selected, scrolling windows are not forced to the foreground. This option applies to all 
Input options that permit the use of the Auto Scroll option (Entire Window, Window Client Area, Last Active
Window, and Region). The default for this option is enabled (checked). Disabling this option may resolve 
problems that can occur when bringing a scrolling window to the foreground has an undesirable side 
effect (e.g., bringing the window to the foreground causes 3D animation to become active).

Selecting Scroll from Top of Document will configure the Auto Scroll feature to always capture scrolling 
windows from the top of the document, for a non-region scrolling capture.    Deselecting this option will 
configure the Auto Scroll feature to capture scrolling windows from the current windowed scroll position, 
for a non-region scrolling capture.    The default for this the option is enabled (checked).



Save Setup
Select the Save Setup option from the SnagIt/32 Toolbar, or Options menu, to save SnagIt/32's current 
configuration options for future SnagIt/32 sessions.
Selecting Save Setup will save the current values for the following settings:

· Input option (Screen, Entire Window, etc.)
· Output option (Printer, Clipboard, File, Mail, etc.)
· Format option (Color, Monochrome, or    Grayscale), including Intensity Threshold for White, if 

applicable
· Alert settings
· Clipboard chain toggle
· Color boost settings
· Scale settings
· Hotkey settings
· Selected printer



Change Hotkeys
Caution: While SnagIt/32 allows users the flexibility to designate their hotkey(s), you should take care to 
use keys and or key combinations that are not used in normal typing or by your other software 
applications.

Select the Change Hotkeys option from the SnagIt/32 Options menu to customize the hotkey(s) you will 
select to capture an image or to hide/unhide the SnagIt/32 icon.
· Select activation key - Allows you to define the keys you will press when you want to capture an 

image. Check the combination of boxes for CTRL, SHIFT, ALT and any keyboard character you want 
to use. You can use any alphabetic character (A-Z), or a function key (F1 - F12) or the Print Screen 
key*. Enter a character by typing it in the box, or use the spin box arrow controls to select it from a 
list.

· Select hide/unhide key - Allows you to define the keys you will press to hide or display SnagIt/32 on 
your desktop. Check the combination of boxes for CTRL, SHIFT, ALT and any keyboard character you
want to use. You can use any alphabetic character (A-Z), or a function key (F1 - F12). Enter a 
character by typing it in the box, or use the spin box arrow controls to select it from a list.

*Note - If you select the Print Screen key as the SnagIt/32 activation hotkey on Windows 95, the 
CTRL and SHIFT keys are not supported. Also, if you need to capture full screen MS-DOS 
windows on Windows NT, do not select the Print Screen key as the SnagIt/32 activation hotkey. 
This will interfere with the normal Print Screen key function in MS-DOS.

To restore the SnagIt/32 default hotkey combinations, (CTRL+SHIFT+P to activate and CTRL+SHIFT+X 
to hide/display), select the Default button.
Example:
If you want to use the key combination CTRL+ALT+C to capture an image, you would check the CTRL 
and ALT boxes under Select activation key, and enter the letter C. Then, to capture a screen, you would 
hold down the CTRL and ALT keys while you press C.



Command Line Arguments
SnagIt/32 accepts the following command line arguments:
/hide or /h Hides the SnagIt/32 window at startup.
/nokey or /n Disables keyboard input to SnagIt/32 (For use with DDE applications.)
/icon or /i Starts SnagIt/32 as a minimized icon.



Using Snagit/32 To Capture MS-DOS Sessions
This chapter describes how you can use SnagIt/32 to capture images from both full-screen and windowed
MS-DOS sessions.
Capturing Full-Screen MS-DOS Sessions     
Capturing Windowed MS-DOS Sessions  
Using The Inverse Option With MS-DOS Window Captures  



Capturing Full-Screen MS-DOS Sessions
Since SnagIt/32 is a Microsoft Windows program, it cannot capture MS-DOS screens directly. However, 
Microsoft Windows will copy an MS-DOS session screen image to the Windows clipboard when you press
the Print Screen key. SnagIt/32 uses this feature to capture the contents of full-screen MS-DOS sessions.
To capture full-screen MS-DOS session with SnagIt/32:

· Set the Input menu option to Clipboard.
· Set the Output menu option to Printer, File or Send Mail.
· You can also select the Clipboard Chain option from the Options menu. If you choose this 

option, SnagIt/32 will capture the image in the Windows clipboard each time the clipboard 
receives something new, and send the captured image to the specified output device.

· We recommend not having the Print Screen key selected as the SnagIt/32 activation hotkey (This
may cause a conflict with the normal MS-DOS function of the Print Screen key).

Once your SnagIt/32 options have been selected, follow these steps to capture full-screen MS-DOS 
sessions:

1. Run your MS-DOS application from Windows, in a full-screen MS-DOS window.
2. When the image you want to capture is on the screen, press the Print Screen key.
3. If you selected the Clipboard Chain option, SnagIt/32 will minimize your MS-DOS session to an 

icon**. SnagIt/32 will then display status and or input windows relevant to the output you have 
selected. When SnagIt/32 has finished processing, select the MS-DOS icon to re-enter your MS-
DOS session.

**Note - If you have selected File, Automatic File Naming as your Output, the MS-DOS 
window will not be minimized and status messages will not appear.

4. If you did not select the Clipboard Chain option, you can still capture the MS-DOS Clipboard 
image manually using the following steps:
· Exit or minimize your MS-DOS session.
· Press your hotkey combination to capture the contents of the Windows clipboard and send 

the image to the specified output device. Again, Input must be Clipboard; Output can be 
anything except Clipboard.

NOTE:
If your MS-DOS application uses a proprietary video mode, you may not be able to use SnagIt/32 to 
capture MS-DOS screens from that application. (When an MS-DOS application uses a proprietary video 
mode, Windows cannot capture the image to the clipboard, so Windows programs like SnagIt/32 cannot 
access the image.)



Capturing Windowed MS-DOS Sessions
You can use SnagIt/32 to capture the screens of windowed MS-DOS applications. To capture the contents
of a windowed MS-DOS session with SnagIt/32:

1. The MS-DOS window must be on top of the Windows desktop.
2. Set the Input menu option to Screen, Entire Window,Window Client Area, Window Client 

Area or Region.
· Screen will capture everything on the Windows desktop, including the MS-DOS window.
· Entire Window will capture the MS-DOS window, including the border, title bar, etc.
· Window Client Area will capture only the contents of the MS-DOS window, without the 

border, title bar and other Windows elements. This option will give you much the same effect 
as capturing a full-screen MS-DOS session.

· Last Active Window will capture the MS-DOS window, including the border, title bar, etc., if it
has the current focus.

· Region will allow you to specify a portion of the screen to capture, and may include the MS-
DOS window.

The other Input options;BMP File and Clipboard, are not applicable. Auto Scroll is also 
unavailable for windowed MS-DOS sessions.

3. Select any Output menu option.
When you have SnagIt/32 set up correctly, use the following steps to capture windowed MS-DOS 
sessions:

1. Run your MS-DOS application in an MS-DOS window.
2. Position the image you wish to capture in the MS-DOS window.
3. Press your hotkey combination to capture the image.



Using The Inverse Option With MS-DOS Window Captures
Because MS-DOS screens and MS-DOS applications often appear as white or light-colored letters on a 
dark background, MS-DOS window screen captures may look better if you use SnagIt/32's Inverse 
option.
To activate SnagIt/32's inverse option, follow these steps:

1. From SnagIt/32's Options menu, select the Color Boost option.
2. On the Color Boost dialog box, select the Inverse button.
3. Select the OK button.

Your captured images will now appear as dark characters on a white background.



Adding Snagit/32 To Other Applications
Using Snagit/32 As A DDE Server     
DDE Command Reference     
Installing The Snagit/32 Word For Windows Macro     
Activating Snagit/32 From Word For Windows     



Using Snagit/32 As A DDE Server
SnagIt/32 is a fully functional Windows Dynamic Data Exchange (DDE) server. You can use SnagIt/32's 
DDE support to incorporate SnagIt/32 functionality into custom or commercial Windows programs that 
support DDE. For example, you could write a Microsoft Excel macro to print a portion of the screen using 
SnagIt/32.



DDE Command Reference
Following is a reference for the DDE commands that a DDE client application can use to communicate 
with SnagIt/32.
For more information about using DDE in Windows programs and macros, refer to the DDE section in the 
Windows Software Developer's Kit reference, Windows Guide to Programming. If you want to incorporate 
SnagIt/32 functionality into a commercial Windows application, you can also refer to the macro language 
documentation for your application.
Please note that the syntax of specific DDE commands (DDE_INITIATE, DDE_EXECUTE, etc.) will vary 
from one application to another, depending on the implementation of DDE commands in the application's 
macro language. The parameters required for accessing SnagIt/32, however, will not vary.
Initiating A DDE Session With Snagit/32     
Setting Snagit/32 Configuration Options     
Invoking Snagit/32     
Invoking Enhanced Snagit/32     
Determining Snagit/32's Status     



Initiating A DDE Session With Snagit/32
To initiate a DDE session with SnagIt/32, you must send a DDE_INITIATE message with the application 
parameter of "SnagIt" and the topic parameter of "System":

[DDE_INITIATE command] SnagIt System

Note: Because it creates the connection, the DDE_INITIATE command must be the first command issued.
To release system resources when the channel is no longer required, issue a DDE_TERMINATE. 



Setting Snagit/32 Configuration Options
You can set SnagIt/32 configuration options — the input, output, format and other options typically set 
through the SnagIt/32 menus — in one of two ways: with the DDE_EXECUTE set command, or with the 
DDE_POKE command.
Setting Options With DDE_EXECUTE     
Setting Options With DDE_POKE     



Setting Options With DDE_EXECUTE
The general syntax of the DDE_EXECUTE set command is:

[DDE_EXECUTE command] set("parameter_value")

With the DDE_EXECUTE set command, the parameter_value may be any one of the following:

Parameter Value Result
add red_nnn, 
blue_nnn,green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set the 
RGB color hue additive values (the three Color Enhance fields on 
the Color Boost dialog) to red_nnn for red, blue_nnn for blue, and 
green_nnn for green.
Separate the RGB additive values by commas, with no spaces 
before or after the commas. 

aspect off Do not maintain image aspect ratio when printing.
aspect on Maintain image aspect ratio when printing.
autoname Set the Filename parameter to CCCCC.
boost off Disable SnagIt/32's Color Boost option (equivalent to de-selecting 

the "Use Color Boost" checkbox on the Color Boost dialog).
boost red_nnn, 
blue_nnn,green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set the 
RGB color saturation multipliers (the three slider bars on the Color 
Boost dialog) to red_nnn for red, blue_nnn for blue, and green_nnn 
for green.
Separate the RGB multiplier values by commas, with no spaces 
before or after the commas. 

chain Toggle the Clipboard Chain parameter.
device [printer_name], 
[driver_name], [port]

Direct output to the specified printer, using specified driver and port.

format color[,n] Set the Format parameter to Color. Set Color Reduction to n colors, 
where n is 0, 16, or 256 (0 specifies no color reduction).    If n is not 
specified, the current color reduction setting is used.

format gray Set the Format parameter to    Grayscale.
format mono[,n] Set the Format parameter to Monochrome, and the Monochrome 

intensity threshold to the value specified as n.
The "mono,n" portion of the string cannot contain spaces. If you do 
not specify a numeric value, SnagIt/32 will use the current intensity 
threshold value as the default.

hidekey nnnn Set hide/unhide hotkey combination to nnnn. The high byte specifies
Control keys:

0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12

Low byte specifies the key pressed:
 0x41-0x5 hotkey’s ASCII value
 0x01-0x0c function key F1-F12,

                                                  if 0x08 bit is set in high byte
inalert n Set the Input # Beeps for the Alert parameter to the value specified 

as n.
input client Set the Input parameter to Window Client Area.
input clipboard Set the Input parameter to Clipboard.
input file Set the Input parameter to BMP File.



input last Set the Input parameter to Last Active Window.
input region Set the Input parameter to Region.
input screen Set the Input parameter to Screen.
input window Set the Input parameter to Entire Window.
mailsubject text Set the Mail Output subject to "text".
mailtext text Include "text" in the message body for Mail Output.
mailname name Set the Mail Output recipient name. If the "mailaddress" parameter is

not set, "name" must be a valid Mail phonebook name. If the 
"mailaddress" parameter is set, "name" may contain the display 
name for the mail recipient.

mailaddress address Set a provider specific Mail Output recipient address. This parameter
is optional if "mailname" specifies a valid Mail phonebook name.

options nnnn Set options. The nnnn byte specifies the following Options:
            0x01 captures mouse cursor
            0x02 turns on Automatic File Naming 
            0x10 turns on Auto Scroll
            0x20 turns on Dithered Color Reduction

options scale,nn Set the scale value for non-printer output, where nn is a real number 
scale multiplier (e.g., 0.73 or 1.28) applied to the image. The value of
nn must be greater than 0.

outalert n Set the Output # Beeps for the Alert parameter to the value specified
as n.

output bmp Set the Output parameter to BMP File.
output cbmp Set the Output parameter to Compressed BMP File.
output clipboard Set the Output parameter to Clipboard.
output file Set the Output parameter to BMP File.
output gif Set the Output parameter to GIF File.
output jpeg[,nn] Set the Output parameter to JPEG File, where n is the desired 

image quality from 1-99%. If n is not specified, the current JPEG 
image quality is used.

output mail Set the Output parameter to Send Mail. The current file output 
configuration is used for the type of attached mail file.
If the mail recipient name or address is specified by the 
"mailname" and/or "mailaddress" parameter, the user will not 
be prompted for information before the mail message is sent.

output pcx Set the Output parameter to PCX File.
output printer Set the Output parameter to Printer.
output tiff Set the Output parameter to TIFF Mono File.
profile active Use the active SnagIt/32 configuration profile for this DDE session.    

This is the same configuration profile used by the SnagIt/32 menus.   
This is the profile used for a DDE session if the "profile" parameter is
not used.

profile default Use the SnagIt/32 default configuration profile for this DDE session.  
Changes only effect this DDE session and do not effect the active 
SnagIt/32 configuration. The "snagkey", "hidekey", and "chain" 
parameters are disabled for this profile setting.

profile saved Use the SnagIt/32 configuration profile saved in the system registry 
for this DDE session. Configuration    changes only effect this DDE 
session and do not affect the active SnagIt/32 configuration. The 
“snagkey", "hidekey", and "chain" parameters are disabled for this 
profile setting.

scale auto Set the Printer Scale option to Auto Scale.
scale n Set the Printer Scale value to n, where n is a percentage of the 



Proportional scale size (e.g., 50, 200 (50% - half size, 200% - double
size)). The value of n must be greater than or equal to 1.

scale page Set the Printer Scale option to Fit on Page.
scale pro Set the Printer Scale option to Proportional scale.
snagdir Set the File Output Directory parameter to a valid path.
snagkey nnnn Set activation hotkey combination to nnnn. The high byte specifies 

Control keys:
0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12
0x10 PRINT SCREEN key

Low byte specifies the key pressed:
0x00 if 0x10 bit is set in high byte
0x41-0x5 specifies hotkey’s ASCII value
0x01-0x0c specifies function key F1-F12, 

if 0x08 bit is set in high byte
window hide Hides the SnagIt/32 window or icon.
window show Displays the SnagIt/32 window or icon.

Examples:
Use DDE_EXECUTE to set the input parameter to clipboard:

[DDE_EXECUTE command] set("input clipboard")

Use DDE_EXECUTE to direct SnagIt/32 output to Microsoft Fax:

[DDE_EXECUTE command] set("device Microsoft Fax, MSFAX, LPT1:")

Use DDE_EXECUTE to set the format parameter to Monochrome and the intensity threshold to 85 
percent:

[DDE_EXECUTE command] set("format mono,85")

Use DDE_EXECUTE to enable Color Boost's color saturation multipliers and set the RGB values:

[DDE_EXECUTE command] set("boost 200,250,200")

Use DDE_EXECUTE to use the application default configuration profile to obtain a known configuration 
and not effect the active application configuration:

[DDE_EXECUTE command] set("profile default")

Use DDE_EXECUTE to send SnagIt/32 output as a compressed BMP file mail attachment:

[DDE_EXECUTE command] set("output cbmp")

[DDE_EXECUTE command] set("output mail")

Use DDE_EXECUTE to send SnagIt/32 output as a mail attachment with the specified Subject and Text.   
The user will be prompted for the mail destination.

[DDE_EXECUTE command] set("output mail")

[DDE_EXECUTE command] set("mailsubject Backup failed!")

[DDE_EXECUTE command] set("mailtext        Why is this happening?")

Use DDE_EXECUTE to send SnagIt/32 output as a mail attachment with the specified Subject to the 
specified recipient.    The user will not be prompted for any information.



[DDE_EXECUTE command] set("output mail")

[DDE_EXECUTE command] set("mailsubject Process monitor 1:03AM")

[DDE_EXECUTE command] set("mailname Operations Staff")



Setting Options With DDE_POKE
The general syntax of the DDE_POKE command is:

[DDE_POKE command] "parameter", "value"

With the DDE_POKE command, the parameter and value strings may be one of the following 
combinations:

Parameter Values Result
add red_nnn, 

blue_nnn, 
green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set 
the RGB color hue additive values (the three Color Enhance fields
on the Color Boost dialog) to red_nnn for red, blue_nnn for blue, 
and green_nnn for green.
Separate the RGB additive values by commas, with no spaces 
before or after the commas. 

aspect on Maintain image aspect ratio when printing.
off Do not maintain image aspect ratio when printing.

autoname ccccc Set the Filename parameters.
boost red_nnn, 

blue_nnn, 
green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set 
the RGB color saturation multipliers (the three slider bars on the 
Color Boost dialog) to red_nnn for red, blue_nnn for blue, and 
green_nnn for green.
Separate the RGB multiplier values by commas, with no spaces 
before or after the commas.

off Disable SnagIt/32's Color Boost option (equivalent to de-selecting 
the "Use Color Boost" checkbox on the Color Boost dialog).

chain Toggle the Clipboard Chain parameter.
format mono[,n] Set the Format parameter to Monochrome, and the Monochrome 

intensity threshold to the value specified as n.
The "mono," portion of the string cannot contain spaces. If you do 
not specify a numeric value, SnagIt/32 will use the current 
intensity threshold value as the default.

color[,n] Set the Format parameter to Color. Set Color Reduction to n 
colors, where n is 0, 16 or 256 (0 specifies no color reduction).    If 
n is not specified, the current color reduction value is used

gray Set the Format parameter to    Grayscale.
hidekey nnnn Set hide/unhide hotkey combination to nnnn. The high byte 

specifies Control keys:
0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12

Low byte specifies the key pressed:
 0x41-0x5 hotkey’s ASCII value
 0x01-0x0c function key F1-F12,

                                                  if 0x08 bit is set in high byte
inalert n Set the Input # Beeps for the Alert parameter to the value 

specified as n.
input screen Set the Input parameter to Screen.

window Set the Input parameter to Entire Window.
client Set the Input parameter to Window Client Area.
last Set the Input parameter to Last Active Window.



region Set the Input parameter to Region.
file Set the Input parameter to BMP File.
clipboard Set the Input parameter to Clipboard.

mailsubject text Set the Mail Output subject to "text".
mailtext text Include "text" in the message body for Mail Output.
mailname name Set the Mail Output recipient name.    If the "mailaddress" 

parameter is not set, "name" must be a valid Mail phonebook
name.    If the "mailaddress" parameter is set, "name" may contain
the display name for the mail recipient.

mailaddress address Set a provider specific Mail Output recipient address.    This 
parameter is optional if "mailname" specifies a valid Mail 
phonebook name.

options nnnn Set options. The nnnn byte specifies the following Options:
                                0x01 captures mouse cursor
                                0x02    turns on Automatic File Naming
                                0x10 turns on Auto Scroll
                                0x20 turns on Dithered Color Reduction

scale,nn Set the scale value for non-printer output, where n is a real 
number scale multiplier (e.g., 0.73 or 1.28) applied to the image. 
The value of n must be greater than 0.

outalert n Set the Output # Beeps for the Alert parameter to the value 
specified as n.

output bmp Set the Output parameter to BMP File.
cbmp Set the Output parameter to compressed BMP File.
clipboard Set the Output parameter to Clipboard.
file Set the Output parameter to BMP File.
gif Set the Output parameter to GIF File.
jpeg[,nn] Set the Output parameter to JPEG File, where n is the desired 

image quality from 1-99%. If n is not specified, the current JPEG 
image quality is used.

mail Set the Output parameter to Send Mail.    The current file output 
configuration is used for the type of attached mail file.
If the mail recipient name or address is specified by the 
"mailname" and/or "mailaddress" parameter, the user will not be 
prompted for information before the mail message is sent.

printer Set the Output parameter to Printer.
tiff Set the Output parameter to TIFF Mono File.
pcx Set the Output parameter to PCX File.

profile active Use the active SnagIt/32 configuration profile for this DDE 
session.    This is the same configuration profile used by the 
SnagIt/32 menus.    This is the profile used for a DDE session if 
the "profile" parameter is not used.

saved Use the SnagIt/32 configuration profile saved in the system 
registry for this DDE session.    Configuration    changes only effect
this DDE session and do not effect the active SnagIt/32 
configuration. The "snagkey", "hidekey", and "chain" parameters 
are disabled for this profile setting.

default Use the SnagIt/32 default configuration profile for this DDE 
session.    Changes only effect this DDE session and do not effect 
the active SnagIt/32 configuration. The "snagkey", "hidekey", and 
"chain" parameters are disabled for this profile setting.

scale auto Set the Printer Scaling to Auto Scale.
n Set the Printer Scale value to n, where n is a percentage of the 

Proportional scale size (e.g., 50, 200 (50% - half size, 200% - 



double size)). The value of n must be greater than or equal to 1.
page Set the Printer Scale option to Fit on Page.
pro Set the Printer Scale option to Proportional scale.

snagdir ddddd Set File Output Directory parameter.
snagkey nnnn Set activation hotkey combination to nnnn. The high byte specifies

Control keys:
0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12
0x10 PRINT SCREEN key

Low byte specifies the key pressed:
0x00 if 0x10 bit is set in high byte
0x41-0x5 hotkey’s ASCII value
0x01-0x0c function key F1-F12, 

if 0x08 bit is set in high byte
window show Displays the SnagIt/32 window or icon.

hide Hides the SnagIt/32 window or icon.

Examples:
Use DDE_POKE to set the input parameter to clipboard:

[DDE_POKE command] "input", "clipboard"

Use DDE_POKE to set the format parameter to Monochrome and the intensity threshold to 85 percent:

[DDE_POKE command] "format", "mono,85"

Use DDE_POKE to enable Color Boost's color saturation multipliers and set the RGB values:

[DDE_POKE command] "boost", "200 250 200"

Use DDE_POKE to use the saved application configuration profile to obtain user tailored settings and not 
effect the active application configuration:

[DDE_POKE command] set("profile saved")

Use DDE_POKE to send SnagIt/32 output as a JPEG file mail attachment:

[DDE_POKE command] set("output jpeg")

[DDE_POKE command] set("output mail")

Use DDE_POKE to send SnagIt/32 output as a mail attachment with the specified Subject and to a 
provider specific mail address.

[DDE_POKE command] set("output mail")

[DDE_POKE command] set("mailsubject Win95 crashed again")

[DDE_POKE command] set("mailaddress SMTP:billg@microsoft.com")

MICROSOFT WINDOWS SDK PROGRAMMER’S TIP:
Note that the data format for DDE_POKE commands must be the valid clipboard format CF_TEXT.



Invoking SnagIt/32 
SnagIt/32's capture process is invoked with the DDE_EXECUTE snag command.
The general syntax of the DDE_EXECUTE snag command is:

[DDE_EXECUTE command] snag([input_parameter])

With the DDE_EXECUTE snag command, you can specify an input parameter value. If you do, this input 
parameter will override SnagIt/32's current input setting. Note that some of the input parameters available
at capture time are not available as pre-set options, either via the SnagIt/32 menus or with DDE 
commands.
The input_parameter used with the DDE_EXECUTE snag command may be any one of the following:

Input Parameter Result
empty or null Capture image using current input and other parameters 

(equivalent to pressing your hotkey sequence).
clipboard Capture image in the Clipboard.
screen Capture the image on the Screen.
[file_name] Capture the image in the specified BMP File.
last Capture the Last Active Window.
x_nnn y_nnn Capture the Entire Window containing the point at the x and y 

coordinates, specified as x_nnn and y_nnn (equivalent to 
using the finger pointer to specify the window to capture).
(Note that the x,y screen coordinate 0,0 is the point in the 
upper left corner of the screen, and that the x coordinate 
represents the point on the horizontal axis, and the y 
coordinate represents the point on the vertical axis. The value 
of the x,y screen coordinate in the bottom right corner of the 
screen depends on your screen resolution.)

client x_nnn y_nnn Capture the Window Client Area containing the point at the x 
and y coordinates, specified as x_nnn and y_nnn. 

handle [window_ handle] Capture the Entire Window of the window specified by 
window_handle(Windows establishes the window_handle. It is 
ascertained by a source other than SnagIt/32.)

client handle [window_ handle] Capture the Window Client Area of the window specified by 
window_handle.

x1_nnn y1_nnn x2_nnn y2_nnn Capture the rectangular area bounded by the first set of xy 
coordinates (specified as x1_nnn and y1_nnn) and the second 
set of xy coordinates (specified as x2_nnn and y2_nnn). The 
result is the same as capturing a Region with SnagIt/32.

exit Terminate SnagIt/32.

Examples:
Capture an image using the current SnagIt/32 input, output, format and other parameters:

[DDE_EXECUTE command] snag()

Capture the bitmapped image stored in the file CAR.BMP, using the current SnagIt/32 output, format and 
other parameters:

[DDE_EXECUTE command] snag("c:\windows\car.bmp")

Capture the rectangular screen area bounded by the xy coordinates at 0,0 and 350,500:



[DDE_EXECUTE command] snag("0 0 350 500")

Capture the window client area for the window with handle "0x43B":

[DDE_EXECUTE command] snag("client handle 0x43B")

Note: You can use numbers in either decimal or hexadecimal format in SnagIt/32 DDE commands. Hex 
values must begin with "0x".



Invoking Enhanced SnagIt/32
SnagIt/32’s capture process can be invoked and configured in a single command string.    The settings 
specified in an Esnag command string only apply to one capture. 
The general syntax of the DDE_EXECUTE Esnag command is:

[DDE_EXECUTE command] Esnag([input_parameter], [output_parameter], [format_parameter], 
[scale_parameter], [options_parameter])

With the DDE_EXECUTE Esnag command, you can specify input, output, format, scale and option 
parameters for a single capture. All parameters will return to saved/default settings after the capture is 
performed. 
 

Input Parameter Result
DEF Captures the default input .
CLP Captures the Clipboard.
SCR Captures the Screen.
LST Captures the Last Active Window. 
BMP Captures a BMP file, where [filename] is an existing Windows 

BMP file.
WIN x y Captures the entire window containing the      point x y.
CLI x y  Captures the Window Client Area containing the                point 

x y.
WHD h Captures the Entire Window specified by the window handle 

h.
CHD h Captures the Window Client Area specified by the window 

handle h. 
REG xl yl x2 y2 Captures the rectangular area specified by the points x1 y1 

and x2 y2. 

Output Parameter Result
DEF Output to default.
CBMP [file_name] Output to a compressed Windows BMP File. (Providing 

[file_name] is optional.)
GIF [file_name] Output to a GIF File (providing file_name is optional).
JPG [file_name] Output to JPEG File using the current configured image 

quality (providing file_name is optional).    Use "set output 
jpeg,n" to set a particular image quality level.

MAIL Send output as a mail attachment.    The current file output 
configuration is used for the type of attached mail file.

PRN Output to the Printer
CLP Output to the Clipboard.
BMP [file_name] Output to a Windows BMP file. (Providing [file_name] is 

optional.)
PCX [file_name] Output to a PCX file. (Providing [file_name] is optional.)
TIF Output to a TIF file. (Providing [file_name] is optional.) 

Format Parameter Result
DEF Implements default format.
COL [n] Implements Color format, setting Color Reduction to n colors, 



where n is 0, 16 or 256 (0 specifies no color reduction).    If n is
not specified, the current color reduction value is used.

MON t Implements Monochrome format with Intensity Threshold for 
White specified by value t.

GRY Implements    Grayscale format. 

Scale Parameter Result
DEF Implements default    printer scale method.
VAL s Scales printer output to s percent of Proportional size. The 

value of s must be greater than or equal to 1.
AUT Set printer output to Auto Scale.
PAGE Set printer output to Fit on Page.
PRO Set printer output to Proportional Scale.

Option Parameter Result
DEF Implements default options.
b Implements options specified by b where b is a bitmask for the

following options:
0 x 01 Include Mouse Cursor
0 x 02 Automatic File Naming
0 x 04 Correct for Aspect Ratio
0 x 08 Invert Image Colors
0 x 10 Enable Auto Scroll
0 x 20 Enable Dithered Color Reduction

Examples:
Capture using default settings for all Esnag parameters. The Esnag command, executed without 
specified parameters, will behave like the snag command executed without specified parameters. 

[DDE_EXECUTE command] Esnag (DEF, DEF, DEF, DEF, DEF)

Capture the Last Active Window. Here , only the input parameter is specified; all other parameters use 
default settings. Therefore, the Esnag command, executed with an input parameter, behaves like the 
snag command executed with a specified parameter. (Remember, the snag command can only use input
parameters.)

[DDE_EXECUTE command] Esnag (LST, DEF, DEF, DEF, DEF)

Capture the Screen to a TIF file named SCREEN1.TIF. Now, both the input and output parameters are 
specified in the Esnag command line; all other parameters use default settings. 

[DDE_EXECUTE command] Esnag (SCR, TIF SCREEN1.TIF, DEF, DEF, DEF)

Capture the Screen to a TIF file name SCREEN1.TIF, this time specifying the format parameter. In the 
Esnag command line, the format parameter is set to color is set to Auto Scale, while the scale and 
options parameters remain set at their defaults.

[DDE_EXECUTE] Esnag (SCR, TIF SCREEN1.TIF, COL, DEF, DEF)

Capture the screen to a TIF file named SCREEN1.TIF , set the format to Color, set scale to default, and 
enable all four options -- Include Cursor, Automatic File Naming, Correct for Aspect Ratio and Invert 
Image Colors. 

[DDE_EXECUTE] Esnag (SCR, TIF SCREEN1.TIF, COL, DEF, 15) 

Note: The Auto File Naming option is overridden by the output setting when it specifies a filename.



Capture the Entire Screen to a TIF file named SCRSHOT1.TIF , set the format to Color , set scale to 
default, and invert the image colors:

[DDE_EXECUTE command] Esnag (SCR, TIF SCRSHOT1.TIF, COL, DEF, 9) 

Capture the entire screen to a JPEG file, set the format to Color, set scale to default, and include the 
mouse cursor: 

[DDE_EXECUTE command] Esnag (SCR, JPG, COL, DEF, 0x01)

Capture the entire screen and send it as a compressed BMP file mail attachment, set the format to Color, 
set the scale factor to default, and include the mouse cursor:

[DDE_EXECUTE command] Set("output cbmp")

[DDE_EXECUTE command] Esnag (SCR, MAIL, COL, DEF, 1)

Capture the default input to a BMP file , set the format to Monochrome with an Intensity Threshold of 40 
and enable the Include Cursor and Automatic File Naming options:

[DDE_EXECUTE command] Esnag (DEF, BMP, MON 40, DEF, 3) 

Capture the window with handle 0x00010062 to the clipboard, set format to reduce to 256 colors, default 
printer scaling (does not apply), and default options.    The "Set" command scales the    image down to 
one half its original size.

[DDE_EXECUTE command] Set("options scale,0.5")

[DDE_EXECUTE command] Esnag (WHD 0x00010062, CLP, COL 256, DEF, DEF)

Capture the window at point 100,200 to the printer, set format to color with no color reduction, scale the 
output to fit on a single printer page, set the Auto Scroll option to capture the entire document in the 
window.

[DDE_EXECUTE command] Esnag (WIN 100 200, PRN, COL 0, PAGE, 0x10)

Note: The maximum length of any DDE command is 80 characters.



Determining Snagit/32's Status
You can query SnagIt/32 about its availability to process another command with the DDE_REQUEST 
status command. The general syntax of the DDE_REQUEST status command is:

[DDE_REQUEST command] status

SnagIt/32 will return either "Ready" or "Busy":
· Ready means SnagIt/32 is available to process another command.
· Busy means SnagIt/32 is currently processing a command.

The ability to query SnagIt/32's status is particularly useful if more than one application is accessing 
SnagIt/32.



Installing The Snagit/32 Word For Windows Macro
The Microsoft Word for Windows macro included on the SnagIt/32 diskette will give you access to 
SnagIt/32 from a MS Word menu. You can use this option to capture screens from other Windows 
applications, and insert those screen captures into your MS Word document.
This macro also illustrates how you can access SnagIt/32 from a commercial application using DDE calls 
in a macro.
Word For Windows 2.0     
Word For Windows 95 And Word For Windows 6.0



Word For Windows 2.0
Follow these steps to install the SnagIt/32 macro in Word for Windows 2.0:

1. Start SnagIt/32, and then start MS Word.
2. Insert the SnagIt/32 distribution diskette in the floppy drive. 
3. Choose File, Open from the MS Word menu. In the File Name field, type:

a:\snagww.doc
(If necessary, substitute the appropriate diskette drive letter for your system.)
This will open the file SNAGWW.DOC in Word.

4. Select the entire document by choosing Edit, Select All from the menu. Then choose Edit, Copy
from the menu to copy the document to the clipboard.

5. Choose Tools, Macro from the menu.
6. In the Macro dialog box, type "ScreenCapture" in the Macro Name field (with no spaces between

the words), and "Activates SnagIt/32" in the Description field.
7. Press the Edit button to open the macro.
8. Choose Edit, Paste from the menu to paste in the body of the SnagIt/32 macro.
9. To assign the SnagIt/32 macro to a MS Word menu item, choose Tools, Options from the menu. 

This will bring up the Options dialog box.
In the Options dialog box, do the following:
· Choose the Menus option from the Category list.
· In the Menu field, select "&Insert" from the list.
· In the Macros field, select "ScreenCapture" from the list.
· Verify that the text in the Menu Text field reads "&Screen Capture". 
· Press the Add button, and then the Close button.

10. Choose File, Close from the menus. Word will prompt you to confirm that you want to keep your 
changes. Select the Yes button.

11. Choose File, Save All from the menus. Word will prompt you to confirm that you want to save the
global glossary and command changes. Select the Yes button.



Word For Windows 95 And Word For Windows 6.0
Follow these steps to install the SnagIt/32 macro in Word for Windows (MS Word) 6.0:

1. Start SnagIt/32, and then start MS Word.
2. Insert the SnagIt/32 distribution diskette in a floppy drive. 
3. Choose File, Open from the MS Word menu. In the File Name field, type:

a:\snagww.doc
(Where “a:\” is the appropriate diskette drive letter for your system.)
This will open the file SNAGWW.DOC in Word.

4. Select the entire document by choosing Edit, Select All from the menu. Then choose Edit, Copy
from the menu to copy the document to the clipboard.

5. Choose Tools, Macro from the menu.
6. In the Macro dialog box, type "ScreenCapture" in the Macro Name field (with no spaces between

the words), and "Activates SnagIt/32" in the Description field.
7. Press the Create button to open the macro.
8. Choose Edit, Paste from the menu to paste in the body of the SnagIt/32 macro.
9. To assign the SnagIt/32 macro to a MS Word menu item, choose Tools, Customize from the 

menu. This will bring up the Customize dialog box.
In the Customize dialog box, do the following:
· Select the Menus folder at the top of the dialog box.
· Choose “Macros” from the Categories list box.
· Select "ScreenCapture" from the Macros list box.
· Select “&Insert” from the Change What Menu drop-down list box.
· Select “(At Bottom)” from the Position on Menu drop-down list box.
· Verify that the text in the Name on Menu field reads "&Screen Capture". 

10. Select the Add button, and then the Close button.
11. Choose File, Close from the menus. Word will prompt you to confirm that you want to keep your 

changes. Select the Yes button.
12. Choose File, Save All from the menu. When Word prompts you to confirm that you want to save 

the global glossary and command changes, select the Yes button.



Activating Snagit/32 From Word For Windows
Once you have installed the SnagIt/32 MS Word macro, follow these steps to activate SnagIt/32 from MS 
Word:

1. Start SnagIt/32, if you have not already done so. You must start SnagIt/32 before you can use the
MS Word screen capture menu option.

2. Set up the Windows application that has the screen you want to capture. (For testing purposes, 
the Windows desktop will work fine.)

3. Return to MS Word, and position the cursor in your MS Word document at the point where you 
want to insert the screen capture.

4. Select Insert, Screen Capture from the MS Word menus. The resulting dialog box will allow you 
to select the area to be captured.

5. Choose the part of the screen you want SnagIt/32 to capture. 
6. Select the OK button. SnagIt/32 will minimize MS Word, allow you to specify which window or 

region you want to capture (unless you specified the entire screen, in which case you will not 
need to select a window or region), and then capture the specified area. When SnagIt/32 is done 
with the screen capture, it will maximize MS Word and insert the captured screen at the insertion 
point.
Once Word has inserted the screen capture into your document, you can move, format, or delete 
it, as you would any other graphic object in MS Word.



Uninstalling SnagIt/32 
This chapter provides information on uninstalling SnagIt/32 from the Windows 95 and Windows NT 
desktop environments.
Note: The procedures outlined here will only work if SnagIt/32 has been installed using the SnagIt/32 
Setup program.

Windows 95 Uninstall     
Windows NT Uninstall     



Windows 95 Uninstall
1. Select the Start button. 
2. Select Settings, Control Panel. 
3. Run the Windows 95 application Add/Remove Programs.    
4. Select Install/Uninstall. Then select SnagIt from the list of applications that can be automatically 

removed by Windows 95.    
5. Select the Add/Remove... button to uninstall SnagIt/32.

If SnagIt/32 does not appear in the list or if the automatic uninstall fails, SnagIt/32 can be uninstalled 
manually.    Please consult the SnagIt/32 README.TXT file for instructions.



Windows NT Uninstall
1. Select File, Run... from the Program Manager.
2. Type the following in the Command Line field:

tscunst /UN

3. Select the OK button to uninstall SnagIt/32.

If the automatic uninstall fails, SnagIt/32 can be uninstalled manually.    Please consult the SnagIt/32 
README.TXT file for instructions.



SnagIt/32 Message Reference
The messages are listed below, alphabetically, in boldface. In the table following each message, the left 
column contains the message number(s), and the right column contains the explanation and actions 
associated with the message number(s).
Note that each message may have more than one number associated with it. Be sure to note the 
message number when contacting SnagIt/32 Technical Support for assistance.
No default printer    
Output canceled by user    
Output device error    
Output exceeds printer capabilities    
Out of memory    
Printer does not support bitmaps    
Windows system error    



No default printer
#9 SnagIt/32 cannot print the captured image because you 

have not specified a Windows default printer. Select a 
default printer in the Windows Control Panel, under 
Printers. Refer to your Windows User's Guide for 
additional information.

Output canceled by user
#5 The user selected the Cancel button, so SnagIt/32 did 

not output the image.

Output device error
#1, #4, #8 SnagIt/32 cannot print the captured image. Check your 

printer to be sure it is on-line and operational.
#13, #14 SnagIt/32 cannot write the specified output file. Check 

disk space, file permissions and attributes. If you are 
outputting the captured image to diskette, verify that the 
diskette is not write-protected, and that it is a working 
diskette.

Output exceeds printer capabilities
#11 The Scale factor is set to a value so large that the printer 

cannot fit the image on one page. Decrease the scale 
factor, or select a smaller screen area to print.

Out of memory
#3, #17 The scale factor for the captured image may be too large 

for the amount of available memory. Try reducing the 
scale factor.
Close any unnecessary applications that may be using 
up Windows resources or memory.
Delete the contents of the clipboard.

#6, #12, #15 Windows cannot allocate the memory SnagIt/32 needs to
perform this capture. Exit and restart Windows; reboot 
your computer if necessary. Contact SnagIt/32 Technical 
Support for assistance.

Printer does not support bitmaps
#2 SnagIt/32 cannot print to the Windows default printer 

because that printer does not support graphics. You 
must use a printer that supports graphics with SnagIt/32.

Windows system error
#7, #10, #16, #18, A basic Windows system function has failed. Exit and 



#19 restart Windows; reboot if necessary.
#20, #21 Your video card driver does not support one or more 

Windows system functions. Obtain and install the latest 
driver from your video card manufacturer. Contact 
SnagIt/32 Technical Support if this does not solve the 
problem.

Answers to Frequently Asked Questions
How do the evaluation and registered versions of SnagIt/32 differ?
Is SnagIt/32 networkable? 
Does SnagIt/32 work with Windows 95 and Windows NT? 
Can I load Win32s and use SnagIt/32 with Windows 3.x? 
What printers are compatible with SnagIt/32? 
How do you capture DOS screens? 
Will SnagIt/32 work if the background and foreground colors are reversed? 
How do I capture a window as text, not graphics? 
How do I print images from a CD-ROM? 
The SnagIt/32 icon showed up in my capture. How can I prevent this? 
How do I increase the printed image size?
The PowerPoint screen display of the image I captured is terrible. Why? 
How do I get SnagIt/32 to capture the screen? 
Why can't I view or edit the screen capture with SnagIt/32? 
What are the different Output File Formats? 
Why is the SnagIt/32 Output->Mail menu item disabled? 
How do I pick the image file type used for Mail output? 
What does it mean when SnagIt/32 complains about a hotkey conflict? 
Why does the screen freeze while selecting a region or window with SnagIt/32? 
I hit the hot key, selected a region and then nothing. I don't seem to be capturing anything. Why? 
The SnagIt/32 hot key isn't working. Why? 
How do I lighten the background color? 
How does SnagIt's Monochrome option work? 
How do SnagIt's Color Boost and Inverse features work? 
Does SnagIt/32 work with Word Perfect using the Clipboard?    



How do the evaluation and registered versions of SnagIt/32 differ?

The downloaded evaluation copy is fully functional, but it has a 45 day time-out and registration reminder 
screens. The time remaining in your evaluation period appears very prominently in the reminder screens 
that occur whenever a screen capture is performed. 



Is SnagIt/32 networkable?

SnagIt/32 can be copied to a file server and then individuals can install SnagIt/32 to their workstation. We 
ask that each person using SnagIt/32 at their workstation have a licensed version defined in the multi-
user pack pricing. 



Does SnagIt/32 work with Windows 95 and Windows NT?

Yes. SnagIt/32 is designed for both of these environments. However, Windows NT users must be running 
version 3.51 or higher to take advantage of SnagIt/32’s latest features. If you are running Windows NT 
3.50 or earlier, please contact TechSmith regarding SnagIt’s current product compatibility. 



Can I load Win32s and use SnagIt/32 with Windows 3.x?

No. If you require a feature of SnagIt/32 , you must run either Windows 95 or Windows NT 3.51 or higher. 



What printers are compatible with SnagIt/32?

SnagIt/32 supports all Windows compatible printers with rastering capabilities. This means the printing 
must be capable of printing bitmapped graphics. Most dot matrix and all laser printers have this ability. 
Plotters would be an example of a printer incompatible with SnagIt. Please be sure to use the latest 
printer driver from the printer's manufacturer. 



How do you capture DOS screens?

To capture full-screen DOS sessions, set the Input option to Clipboard. Set the Output option to anything 
except the Clipboard. Select the Clipboard Chain option from the Options menu. Run your DOS 
application from Windows. Press the PRINT SCREEN key. This will cause you to return to Windows while
SnagIt/32 captures the input. Double click on the minimized DOS session to re-enter the DOS application.



Will SnagIt/32 work if the background and foreground colors are reversed?

Yes. Select the Inverse option in the Color Boost dialog box. This is particularly handy when you're trying 
to capture    DOS windows.



How do I capture a window as text, not graphics?

SnagIt's screen capture and conversion features are limited to graphic file formats. Translating images of 
characters into edittable text files requires some type of OCR (Optical Character Recognition) conversion 
of the image. While this is not something SnagIt/32 does, there are several commercial packages 
available, many of the most popular come bundled with new scanners. These programs actually work by 
recognizing character shaped areas in the image and matching them to editable text characters. The 
results are then output in a word processing format of your choice. SnagIt/32 has a special Inverse option 
under Options, Color Boost that can help you in this effort. It takes light colored text on a dark background
and inverts the image so you get the dark letters on a light page. This is the format that most OCR 
software applications are most accustomed to.



How do I print images from a CD-ROM?

If the images on the CD are in BMP format, you can print them directly from the CD by setting your 
SnagIt/32 INPUT option to BMP File and your OUTPUT option to Printer. Invoking SnagIt's "hotkey" 
sequence (the default is [CNTL]+[SHIFT]+P) would then allow you to select the drive, directory and file 
you wish to print. 
If the images are not in BMP format, first view the images with the Windows graphic viewer of your 
choice. Once the image is displayed, you would then invoke SnagIt/32 with the "hotkey" sequence. Your 
SnagIt/32 INPUT option should be set to the area you wish to capture (usually Last Active Window). 



The SnagIt/32 icon showed up in my capture. How can I prevent this?

You can hide the SnagIt/32 icon or window. Use the SnagIt/32 Hide key, (default: CNTL+SHIFT+X), to 
toggle between hiding and capturing the SnagIt/32 icon or window. You can also hide SnagIt/32 on startup
by adding the "/h" parameter to the command line. 



How do I increase the printed image size?

SnagIt's default setting is “Fit Image on a Single Page”. This means that SnagIt/32 will scale the image, 
regardless of length, to print on a single page. This setting often results in a smaller printed image than is 
preferred. To adjust the image size, we recommend beginning with “Use Screen Image Size” and 
experimenting with the various scale options. 



The PowerPoint screen display of the image I captured is terrible. Why?

A common problem exists when inserting certain screen shots into applications like PowerPoint. Because 
the physical size of the image is often too large for the PowerPoint "page size", PowerPoint will shrink the 
image. The resulting image looks badly distorted. PowerPoint does not do a good job in shrinking the 
image. The obvious workarounds are to increase the page size or reduce the captured image size. There 
are also ways in PowerPoint to scale the image back up to original size. This will always be an issue if a 
1:1 image display cannot be set in PowerPoint. 
For on-screen presentations we recommend keeping the captured area tightly focused on the portion of 
the image you actually require. This keeps the overall size down and reduces the effect of any scaling 
that you may not have control over. Also avoiding "busy" backgrounds and patterns that can look pretty 
strange when they are arbitrarily scaled down. 
We've also found that the distortion is only a visual screen effect and will vary depending on the resolution
and application in use. It has little or no effect on the printed output. We've printed out PowerPoint 
presentations with a SnagIt/32 capture and the print looks great, no detail loss what so ever. 



How do I get SnagIt/32 to capture the screen?

SnagIt/32 is "hotkey" driven. Just press the SnagIt/32 hotkey combination to capture the screen. The 
default SnagIt/32 hotkey combination is CTRL+SHIFT+P. Note that the SnagIt/32 hotkey combination can
be configured using the Options->Change Hotkeys menu. The current hotkey can be displayed by 
selecting Help->Quick Help.



Why can't I view or edit the screen capture with SnagIt/32?

SnagIt/32 is not a general purpose image viewer or image processing program. SnagIt/32 specializes in 
easy to use and high quality screen capture. SnagIt/32 has several image processing options which may 
be set using the Format and Options menus. By supporting many Output file types and Output to the 
Windows Clipboard, SnagIt/32 works with general purpose image viewers and image processing 
programs when they are needed. 



What are the different Output File Formats?

Windows Bitmap (.BMP) is a standard Windows image file format. Bitmap files are one of the most 
commonly used image file format on Windows systems and are widely supported by Windows 
applications. Bitmap files are a simple image file format and are very close to the native image format 
used internally by the Windows operating system. Bitmap files are typically uncompressed. The file size 
for a screen capture will depend directly on the screen resolution and number of colors. However, Bitmap 
files have a compression option described below. 
Compressed Bitmap (.BMP) is an optional compressed Window Bitmap format for 16 and 256 color 
images. Compressed Bitmaps shrink areas of the image which have the same color by using "run length 
encoding". This can dramatically reduce the size of the image file, especially for screen captures (since 
they often have large areas of the same color). However, Compressed Bitmap files are not as widely 
supported by Windows applications as uncompressed Bitmap files. 
PC Paintbrush (.PCX) is one of the earliest attempts to standardize image file formats on PCs. This 
image file format was made popular by the PC Paintbush program and then became a defacto standard. 
PC Paintbrush files are widely supported by graphics applications. PC Paintbrush files always shrink the 
areas of the image which have the same color by using "run length encoding". This can dramatically 
reduce the size of the image file, especially for screen captures. 
Tag Image File (.TIF) was created to become the industry standard image file format. Also known as 
Tagged Image File Format (TIFF), this file format is widely supported by graphics applications on many 
different types of computers besides the Windows PC. TIF files are supported by about every desktop 
publishing program. TIF files are known for their portability, and rich set of possible options. SnagIt/32 
currently does not support any of the TIF compression options. 
JPEG (.JPG) image files are compressed by discarding "extra" data that the human eye "cannot see". 
Because JPEG discards data, it is referred to as "lossy." JPEG image files are typically much smaller than
other file formats and are widely used for communicating images over the Internet. However, when a 
JPEG image is decompressed and viewed, it will not be identical to the original image. With JPEG, you 
can select the quality of the compressed image. The lower the quality, the smaller the image but the more
different it will look than the original image. SnagIt/32 supports image quality levels from 1% to 99%. The 
JPEG image file format works best for images with many colors and a large variation of colors (e.g., a 
scanned photo or multimedia CD display). Using JPEG for images with only a few colors (e.g., a database
form) will result in a small image but poor image quality. 
GIF (.GIF) was designed by CompuServe for exchanging images between a wide variety of computers. 
Graphics Interchange Format (GIF) is now one of the most popular image formats used to distribute 
images over the Internet.    GIF compresses the image without incurring a loss in image quality.    GIF 
does not support images with more than 256 colors.    If your display setting is higher than 256 colors, 
SnagIt/32 provides a color reduction option (select Format, Color) to reduce the number of image colors 
to 256.



Why is the SnagIt/32 Output->Mail menu item disabled?

The SnagIt/32 Mail output option requires a 32-bit mail client application (e.g., Microsoft Exchange) to be 
installed and configured on your system. Install a 32-bit mail client which supports MAPI enabled 
applications. 



How do I pick the image file type used for Mail output?

SnagIt/32 uses the currently configured Output->File image file type for the file attached to Mail output. To
send a capture as a PCX file using Mail, first select Output->File and pick the PCX file format. Then, 
select Output->Mail and activate a capture with the SnagIt/32 hotkey. 



What does it mean when SnagIt/32 complains about a hotkey conflict?

Only one Windows application can own a particular hotkey combination. Some other application has 
registered the currently configured SnagIt/32 hotkey combination. Use the Options->Change Hotkeys 
menu to select a different SnagIt/32 hotkey combination. 



Why does the screen freeze while selecting a region or window with SnagIt/32?

SnagIt/32 takes a snapshot of the screen at the time the SnagIt/32 hotkey is pressed when are region or 
window is selected for Input. This is done so that drop-down menus, pop-up/system menus, and 
multimedia animation can be easily captured. SnagIt/32 does not effect the real behavior of the Windows 
desktop or applications, the "freeze frame" is simulated only to aid screen capture. 



I hit the hot key, selected a region and then nothing. I don't seem to be capturing anything. Why?

This most often occurs with users who select File as an Output option and also select Automatic File 
Naming to sequentially name and number the files. This, combined with the quickness of the software, 
results in no visible confirmation being displayed when a capture occurs, especially if you are specifying a
small region of the screen. You may want to check the default directory specified under Output, File, 
Automatically Name (default C:\SNAGIT) for saved images or, as an alternative, temporarily select Printer
as your Output for confirmation of functionality. 
If you find that you are not getting results from either of these methods, please contact TechSmith 
Technical Support with further details on your system setup and other applications that are being run, so 
that we can assist you in resolving this issue. 



The SnagIt/32 hot key isn't working. Why?

It's possible that another application is using the same hot key as SnagIt/32. First, try exiting and 
restarting SnagIt. This often resolves temporary hotkey conflicts. Next, try changing the hotkey setup for 
SnagIt/32. You do this by selecting Options->Change Hotkeys from the SnagIt/32 window. Experiment 
with various hot key combinations. You may need to restart Windows after changed the hotkey.



How do I lighten the background color?

To adjust or eliminate gray background colors you can try experimenting with the Color Boost section 
under Options. Be sure to select the "Use Color Boost" checkbox and make your adjustments to the 
sliding bars at the top of the screen. To lighten colors across the entire spectrum move all of the bars an 
equal amount to the right. If the background you are trying to eliminate has an obvious color bias, i.e., red 
or blue or green, you may want to adjust that bar alone. Remember that you can always start over by 
selecting the Default button and by deselecting "Use Color Boost". 
Another alternative is to try changing the SnagIt/32 Format option to Monochrome. This may result in an 
unacceptable image, due to the image being reduced to only black and white areas. If the monochrome 
capture still prints gray in your application you might investigate how the application handles imported 
images. 



How does SnagIt's Monochrome option work?

The Format->Monochrome... option translates all pixels to white or black (only). 
SnagIt/32 uses the RGB color model. Screen colors are composed of red, green and blue components. 
SnagIt/32 converts each color to its grayscale component using the standard grayscale equation: 
Greyscale value = 0.30 * red + 0.59 * green + 0.11 * blue. (See Bit-Mapped Graphics, 1990 by Steve 
Rimmer) 
This Grayscale value is converted to the range 0 to 100. The resulting value is compared to the Intensity 
Threshold for White value set in the Format->Monochrome... dialog box. If the Grayscale value is greater 
than the Intensity Threshold, the pixel is converted to white. Otherwise it is converted to black. 



How do SnagIt's Color Boost and Inverse features work?

The Options->Color Boost... dialog box is used to enable Color Boost and set the RGB boost values. 
Those values can range from -1 to +10. They are multiplied by the original color component value to 
create the boosted value. The value that are selected in the Color Enhance edit fields are added to the 
boosted value. These values can range from -255 to +255. Algebraically: 
For each of the color componets; red, green and blue: 
Boosted value = (original value * scrollbar value) + color enhance value 
If the Inverse option is selected, SnagIt/32 converts each of the color components to its mathematical 
RGB inverse: 
Inverted value = 255 - abs(RGB value) 



Does SnagIt/32 work with Word Perfect using the Clipboard?

Apparently, WordPerfect struggles with the graphics file format that SnagIt/32 places in the Clipboard. The
issue seems to be more pronounced in black and white images than in color. To our knowledge, 
WordPerfect is the only popular document creation package to exhibit this behavior. The current 
workaround we suggest is to bypass WordPerfect's interaction with the Clipboard by directing SnagIt's 
output to the WordPerfect compatible file format of your choice. The resulting imported files appear to be 
more compatible with WordPerfect's expectations.
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TechSmith Corporation
TechSmith Corporation is a technology leader in remote networking solutions.    Since 1987 our mission 
has been to help users maximize the benefits of distributed computing by allowing effective remote 
deployment and use of distributed data and services. TechSmith has designed its family of products to 
meet the unique requirements of organizations needing to support not only their employees, but their 
customers, vendors, and business partners as well. The company has more than 1000 customers, many 
of which are Fortune 100 organizations.
TechSmith is committed to providing reliable, high-quality products that are easy to use. If you have a 
product suggestion or would like more information regarding SnagIt/32, please contact us in one of the 
following ways:

Mail: TechSmith Corporation
Attn.: SnagIt/32 Support
PO Box 4758
East Lansing, MI    48826-4758

Phone: (517) 333-2100
Fax: (517) 333-1888
E-mail: snagit@techsmith.com
Internet: http://www.techsmith.com
CompuServe: 75226,3136



Other TechSmith Products
Enterprise Wide Foray PPP ServerÔ
Enterprise Wide Foray PPP Server is a cost efficient communications software solution for accessing 
corporate network resources. The Foray PPP Server brings the corporate Internet connection, as well as 
TCP/IP and IPX network services, to the remote user. 
Supporting individuals dialing in with Windows 95, Windows NT, WinSock PPP packages, and PPP 
clients, Foray can provide a centralized remote-access service point.    Network administrators can save 
time and money while providing multiple users with a secure LAN and Internet link. 
An evaluation version is available at http://www.techsmith.com. 
Send email requests for additional information to foray@techsmith.com. 
 

SnagItÔ (16-bit version)
SnagIt is the screen capture, print and file program for Microsoft Windows 3.x. Users can capture an 
entire screen, a portion of the screen or a single window. SnagIt sends the captured area to the clipboard,
printer or a file for later use in other applications, such as word processors. SnagIt is a fully functional 
Windows DDE    server so it may be incorporated into custom or commercial applications for printing . 
An evaluation version is available at http://www.techsmith.com. 
Send email requests for additional information to snagit@techsmith.com.    
    



Sales Information
For further sales information, please contact the nearest SnagIt distributor.

United States
Contact: TechSmith Corporation
Mail: TechSmith Corporation

Attn.: SnagIt/32 Sales
PO Box 4758
East Lansing, MI    48826-4758

Phone: (800) 517-3001 or
(517) 333-2100

Fax: (517) 333-1888
E-mail: snagit@techsmith.com
Internet: http://www.techsmith.com
CompuServe: 75226,3136

Canada
Contact: Datamex Technologies
Phone: (416) 665-1808

Contact: Egghead Software
Phone: (604) 688-9984

Contact: Stream International
Phone: (800) 699-2095

Germany
Contact: ADN
Mail: ADN

Herner Strasse 299
D-44809, Bochum GERMANY

Phone: (49 2) 34 54 1018

United Kingdom
Contact: Atlantic Coast plc
Mail: Atlantic Coast plc

The Shareware Village
Colyton
Devon EX13 6HA
England

Phone: (01) 297 552222
Fax: (01) 297 553366

France



Contact: WinShare SARL
Mail: WinShare SARL

46-48 Route de Thionville
Zone Maison Neuve
57140-WOIPPY
France

Phone: (33) 87 30 85 57
Fax: (33) 87 32 37 75

Scandinavia / Benelux
(Sweden, Norway, Finland, Denmark, Netherlands, Belgium and Luxemborg)

Contact: CD & E
Mail: CD & E

Watercirkel 79
NL-1186 LP Amstelveen

Phone: (31) (0)20-6438106
Fax: (31) (0)20-6438106
E-mail: cde@xs4all.nl
Internet: http://www.tip.nl/braderie/cde

Countries Not Listed
Contact: TechSmith Corporation
Mail: TechSmith Corporation

Attn.: SnagIt/32 Sales
PO Box 4758
East Lansing, MI    48826-4758
USA

Phone: (800) 517-3001 or
(517) 333-2100

Fax: (517) 333-1888
E-mail: snagit@techsmith.com
Internet: http://www.techsmith.com
CompuServe: 75226,3136
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Professionals (ASP). ASP wants to make sure that the shareware principle works for you. If you are 
unable to resolve a shareware-related problem with an ASP member by contacting the member directly, 
ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP 
member, but does not provide technical support for members’ products. Please write to the ASP 
Ombudsman at 545 Grover Road, Muskegon, MI USA 49442-9427, fax (616) 788-2765, or send a 
CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536.



Software License Agreement

END-USER LICENSE AGREEMENT FOR TECHSMITH SOFTWARE -- SnagIt/32

IMPORTANT-READ CAREFULLY: This TechSmith Software License Agreement ("TSLA") is a legal 
agreement between you (either an individual or a single entity) and TechSmith Corporation for the 
TechSmith software product identified above, which includes computer software and associated media 
and printed materials, and may include "online" or electronic documentation ("SOFTWARE PRODUCT" or
"SOFTWARE").    By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be 
bound by the terms of this TSLA.    If you do not agree to the terms of this TSLA, promptly return the 
unused SOFTWARE PRODUCT to the place from which you obtained it for a full refund.

SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties.    The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE
This TSLA grants you the following rights:

Systems Software -    You may install and use one copy of the SOFTWARE PRODUCT on a single 
computer at a time and only by one user at a time.

Storage/Network Use -    You may also store or install a copy of the SOFTWARE PRODUCT on a 
storage device, such as a network server, used only to install or run the SOFTWARE PRODUCT on 
your other computers over an internal network; however, you must acquire and dedicate a license for
each separate computer on which the SOFTWARE PRODUCT is installed or run from the storage 
device.    A license for the SOFTWARE PRODUCT may not be used concurrently on different 
computers.

License Pack -    If you have acquired this TSLA in a TechSmith Multi-User License Pack, you may 
make the number of additional copies of the computer software portion of the SOFTWARE 
PRODUCT authorized on the printed copy of this TSLA, and you may use each copy in the manner 
specified above.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

Limitations on Reverse Engineering, Decompilation, and Disassembly -    You may not reverse 
engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that 
such activity is expressly permitted by applicable law not withstanding this limitation.

Separation of Components -    The SOFTWARE PRODUCT is licensed as a single product.    Its 
component parts may not be separated for use on more than one computer.

Rental -    You may not rent or lease the SOFTWARE PRODUCT.

Software Transfer -    You may permanently transfer all of your rights under this TSLA, provided you 
retain no copies, you transfer all of the SOFTWARE PRODUCT (including all component parts, the 
media and printed materials, any upgrades and this TSLA), and the recipient agrees to the terms of 
this TSLA.    If the SOFTWARE PRODUCT is an upgrade, any transfer must include all prior versions
of the SOFTWARE PRODUCT.

Termination -    Without prejudice to any other rights, TechSmith may terminate this TSLA if you fail 
to comply with the terms and conditions of this TSLA.    In such event, you must destroy all copies of 



the SOFTWARE PRODUCT and all of its component parts.

3. UPGRADES --    If the SOFTWARE PRODUCT is an upgrade from another product, whether from 
TechSmith or another supplier, you may use or transfer the SOFTWARE PRODUCT only in 
conjunction with that upgraded product, unless you destroy the upgraded product.    If the 
SOFTWARE PRODUCT is an upgrade of a TechSmith product, you now may use that upgraded 
product only in accordance with this TSLA.    If the SOFTWARE PRODUCT is an upgrade of a 
component of a package of software programs that you licensed as a single product, the 
SOFTWARE PRODUCT may be used and transferred only as part of that single product package 
and may not be separated for use on more than one computer.

4. COPYRIGHT --    All title and copyrights in and to the SOFTWARE PRODUCT (including but not 
limited to any images, photographs, animations, video, audio, music, text, and "applets," 
incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies 
of the SOFTWARE PRODUCT, are owned by TechSmith or its suppliers.    The SOFTWARE 
PRODUCT is protected by copyright laws and international treaty provisions.    Therefore, you must 
treat the SOFTWARE PRODUCT like any other copyrighted material except that you may either (a) 
make one copy of the SOFTWARE PRODUCT solely for backup or archival purposes, or (b) install 
the SOFTWARE PRODUCT on a single computer provided you keep the original solely for backup 
or archival purposes.    You may not copy the printed materials accompanying the SOFTWARE 
PRODUCT.

5. DUAL-MEDIA SOFTWARE --    You may receive the SOFTWARE PRODUCT in more than one 
medium.    Regardless of the type or size of medium you receive, you may use only one medium that 
is appropriate for your single computer.    You may not use or install the other medium on another 
computer.    You may not loan, rent, lease, or otherwise transfer the other medium to another user, 
except as part of the permanent transfer (as provided above) of the SOFTWARE PRODUCT.

6. U.S. GOVERNMENT RESTRICTED RIGHTS --    The SOFTWARE PRODUCT and documentation 
are provided with RESTRICTED RIGHTS.    Use, duplication, or disclosure by the Government is 
subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the 
Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.    
Manufacturer is TechSmith Corporation/3001 Coolidge Road, Suite 400, East Lansing, MI 48823-
6320.

MISCELLANEOUS
If you acquired this product in the United States, this TSLA is governed by the laws of the State of 
Michigan.
If you acquired this product in Canada, this TSLA is governed by the laws of the Province of Ontario, 
Canada.    Each of the parties hereto irrevocably attorns to the jurisdiction of the courts of the Province of 
Ontario and further agrees to commence any litigation which may arise hereunder in the courts located in 
the Judicial District of York, Province of Ontario.
If this product was acquired outside the United States, then local law may apply.
Should you have any questions concerning this TSLA, or if you desire to contact TechSmith for any 
reason, please contact the TechSmith subsidiary serving your country, or write: TechSmith 
Corporation/3001 Coolidge Road, Suite 400, East Lansing, MI 48823-6320.

LIMITED WARRANTY
TechSmith warrants that (a) the SOFTWARE PRODUCT will perform substantially in accordance with the 
accompanying written materials for a period of ninety (90) days from the date of receipt, and (b) any 
hardware accompanying the SOFTWARE PRODUCT will be free from defects in materials and 
workmanship under normal use and service for a period of one (1) year from the date of receipt.    Some 
states and jurisdictions do not allow limitations on duration of an implied warranty, so the above limitation 
may not apply to you.    To the extent allowed by applicable law, implied warranties on the SOFTWARE 
PRODUCT and hardware, if any, are limited to ninety (90) days and one year, respectively.



CUSTOMER REMEDIES
TechSmith's and its suppliers' entire liability and your exclusive remedy shall be, at TechSmith's option, 
either (a) return of the price paid, or (b) repair or replacement of the SOFTWARE PRODUCT or hardware 
that does not meet TechSmith's Limited Warranty and which is returned to TechSmith with a copy of your 
receipt.    This Limited Warranty is void if failure of the SOFTWARE PRODUCT or hardware has resulted 
from accident, abuse, or misapplication.    Any replacement SOFTWARE PRODUCT or hardware will be 
warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. 
Outside the United States, neither these remedies nor any product support services offered by 
TechSmith are available without proof of purchase from an authorized international source.

NO OTHER WARRANTIES
To the maximum extent permitted by applicable law, TechSmith and it’s suppliers disclaim all 
other warrantees, either express or implied, including, but not limited to, implied warrantees of 
merchantability and fitness for a particular purpose, with regard to the software product, and any 
accompanying hardware.    This limited warranty gives you specific legal rights.    You may have 
others, which vary from state/jurisdiction to state/jurisdiction.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES
To the maximum extent permitted by applicable law, in no event shall TechSmith or it’s suppliers 
be liable for any special, incidental, indirect, or consequential damages whatsoever (including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or any other pecuniary loss) arising out of the use of or inability to use the software 
product, even if TechSmith has been advised of the possibility of such damages.    Because some 
states and jurisdictions do not allow the exclusion or limitation of liability for consequential or 
incidental damages, the above limitation may not apply to you.



Aspect ratio
The width to height ratio of a screen image.



BMP File
Windows bitmap files have a file extension of .BMP. Windows Paint and other graphics programs 
generate graphic files in this format. Most Windows word processing and desktop publishing programs 
easily import bitmap files into documents.



Command line
The commands you type to run an application. For Windows applications, you enter command line 
arguments in the Run dialog box in File Manager or Program Manager



Default settings
The input, output, format, and other option settings that SnagIt/32 uses unless you specify otherwise.



Dialog box
A window that appears temporarily to request information. Many dialog boxes allow you to select options 
or specify parameters that SnagIt/32 will use to carry out a command.



DPI
Dots Per Inch, typically used to reference printer resolution or clarity. Higher DPI printers are capable of 
producing sharper images.



Entire Window
A SnagIt/32 input option that will capture an entire window, including the border, title bar, menu bar, scroll 
bars and caption line.



File name
A valid file name that conforms to MS-DOS file naming conventions.



Finger pointer
A finger-shaped cursor that you use to select an Entire Window or Window Client Area to capture.



Focus
In Microsoft Windows, the window which has the focus is the one that will receive the next keyboard or 
mouse input. Also, the title bar of the window with the focus will typically be a different color than the title 
bar of other windows.



Hotkey
A key or combination of keys that you press to execute a command or action. The default hotkey 
sequence for invoking SnagIt/32 is CTRL+SHIFT+P.



Last Active Window
A SnagIt/32 input option that captures the last active window (the window that has the focus on the 
Windows desktop when SnagIt/32 is invoked).



MS-DOS window
A MS-DOS session running from Windows. A MS-DOS window can occupy the entire screen, or run in a 
smaller window on the desktop.



PCX File
A graphic file in Windows PC Paintbrush format. Windows PC Paintbrush files have a file extension 
of .PCX..



Pixel
A graphic unit that consists of a single dot on a monitor screen.



TIFF File
A graphic file in Tagged Image File Format. TIFF files have a file extension of .TIF. A wide variety of 
application programs on a number of platforms support this format. SnagIt/32 can create only 
monochrome TIFF files.



Window Client Area
A SnagIt/32 input option that captures the client area of a specific window. The client area is the main 
body of the window inside the window borders. It does not include the window borders, title bar, menu bar,
scroll bars or caption line.



Windows application
An application designed to run under Microsoft Windows, which you can only start from Windows, and 
can only run while Windows is running.



Windows clipboard
A location that Windows uses for temporary storage. You can use the clipboard to hold data that you want
to move to a different place in a document, between documents, or between applications. An application's
cut, copy, and paste commands move data into and out of the clipboard. You can use the Clipboard 
Viewer to view the contents of the Clipboard.



Windows default printer
The printer to which Windows applications will send your output if you choose a Print command without 
specifying which printer you want to use. You can select a Windows default printer from the Windows 
Control Panel or Print Manager.



Region
A SnagIt/32 input option that captures any rectangular region of the screen.

 




